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UVOD



Matlab / Octave

Matlab (MATrix LABoratory) je programsko okruženje za tehničko i
znanstveno računanje.

GNU Octave je besplatni, open-source klon Matlaba.

Omogućavaju:
• izvođenje kompleksnih proračuna
• vizualizaciju rezultata
• izvođenje simulacija
• programiranje

Matlab ima vlastiti (interpretirani) programski jezik visokog nivoa koji
je jednostavan za korištenje i upotrebljava standardiziranu
matematičku sintaksu. Podržava i objektno-orijentirani pristup.

Brojnim toolboxovimamoguće je jako proširiti funkcionalnost.
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https://www.mathworks.com/products/matlab.html
https://www.gnu.org/software/octave/index


RAD U INTERAKTIVNOJ KONZOLI



Korisničko sučelje
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Korisničko sučelje

Dijelovi korisničkog sučelja:

• Command Window – interaktivna konzola u koju utipkavamo
naredbe i vidimo njihov rezultat

• Workspace – popis svih varijabli i njihova osnovna svojstva
• Command History – popis ranije izvršenih naredbi
• Current Folder – trenutni direktorij u kojem se nalaze programi
dostupni za izvršavanje, vidi ovdje za detalje.
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Help

Matlab dolazi sa vrlo iscrpnim sustavom pomoći, pod menijem Help
→ Documentation.

Osim toga, pomoć je dostupna u interaktivnoj konzoli:

1 help eig; % kratki info o naredbi eig, ispiše se u konzoli
2 doc eig; % detaljna dokumentacija o naredbi eig

Sve dokumentacija je dostupna i online.
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https://www.mathworks.com/help/matlab/


Unošenje naredbi

Svaka naredba u Matlabu može i ne mora završavati točka-zarezom.

Naredbe koje ne završavaju točka-zarezom rezultiraju ispisom
izračunate vrijednosti na ekran:

1 a = sqrt( ‐1 )

a =
0 + 1.0000i

Rezultat naredbi koje završavaju točka-zarezom neće biti ispisan:

1 a = sqrt( ‐1 );

|

Ekran možemo obrisati naredbom clc;
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Unos elementarnih varijabli

• 0.314 ili 3.14e‐1 – realni broj (double)
• ‐3+0.5i – kompleksni broj
• 'x' – char
• 'iter' – string (1D polje charova)
• true, false – logička vrijednost (logical)
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Načini ispisa decimalnih brojeva

Matlab može ispisivati realne brojeve u 4 osnovna formata. Ako
utipkamo sljedeće naredbe i ispišemo vrijednost od a=31.4, ispisi su:

1 format short

31.400

1 format long

31.40000000000000

1 format short e

3.1400e+001

1 format long e

3.140000000000000e+001
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TIPOVI PODATAKA U MATLABU I
VARIJABLE



Tipovi podataka

Matlab je slabo tipiziran jezik. Nije potrebno deklarirati varijable;
pojedine varijable mogu mijenjati svoj tip “u letu”:

1 a = [1 2 3]
2 a = 'pero'
3 a.element = 123

a =
1 2 3

a =
pero

a =
element: 123
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Tipovi podataka

Bazični tipovi podataka u Matlabu su npr. single, double, char,
logical, int32 …

Ali svaka varijabla je zapravo 2D-matrica nekog od bazičnih tipova.

U Matlabu osim matrica postoje i sljedeći tipovi podataka:

• 3 i više dimenzionalna polja
• Strukture – kao struct u C-u.
• Cell-array – 1 ili više dimenzionalno polje elemenata koji mogu
biti različitih tipova.

• Objekti – slično kao u C++ (strukture čiji članovi mogu biti i
funkcije).
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Varijable

Tip varijable možemo ispitati pomoću is???? funkcija.

1 a = 3 + 2i;
2 isnumeric( a )
3 ischar( a )
4 islogical( a )
5 isstruct( a )
6 iscell( a )
7 isreal( a )

Tip varijable xmožemo ispisati pomoću naredbe whos x.
Tipove svih deklariranih varijabli doznajemo pomoću whos.

Varijablu xmožemo “oddeklarirati” pomoću clear x.
Sve varijable možemo “oddeklarirati” pomoću clear.

15



Varijable

Deklarirane varijable možemo spremiti u binarnu mat datoteku i
kasnije ih ponovno učitati.

Varijable x, yy, ZZZ spremamo u datoteku var.mat pomoću

1 save( 'var.mat', 'x', 'yy', 'ZZZ' );

Sve deklarirane varijable spremamo u datoteku var.mat pomoću

1 save( 'var.mat' );

Varijable x, yy, ZZZ učitavamo iz datoteke var.mat pomoću

1 load( 'var.mat', 'x', 'yy', 'ZZZ' );

Sve varijable koje postoje u datoteci var.mat učitavamo sa

1 load( 'var.mat' );
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MATRICE



Zadavanje matrica

Matrice možemo zadati ovako:

1 A = [1 2 3; 4 5 6]

A =
1 2 3
4 5 6

Možemo posložiti druge vektore i/ili matrice u novu matricu:

1 X = [1 2; 3 4]; Y = [7; 8];
2 A = [X Y]
3 B = [X; 7 8]

A =
1 2 7
3 4 8

B =
1 2
3 4
7 8
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Zadavanje matrica

Postoje brze naredbe za stvaranje nul-matrice (zeros), jedinične
matrice (eye), matrice pune jedinica (ones), random matrice sa
uniformnom (rand) i normalnom (randn) distribucijom elemenata:

1 A = zeros( 5 );
2 B = ones( 3, 4 );
3 C = eye( 5 );
4 D = eye( 3, 6 );
5 E = rand( 6, 3 );
6 F = randn( 1 );
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Zadavanje matrica

Postoje i brze naredbe za zadavanje matrica tipa 1× n:

1 3:7

ans =
3 4 5 6 7

1 3:6:30

ans =
3 9 15 21 27

1 1.2 : 3.4 : 12.7

ans =
1.2000 4.6000 8.0000 11.4000
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Pristup elementima matrice

• A(r, s)
Element u retku r i stupcu s.

• A(r1:r2, s1:s2)
Podmatrica koja uključuje retke od r1 do r2 i stupce od s1 do s2.

• r=[3 5]; s=[7 2]; A(r,s)
Podmatrica koja sadrži retke 3 i 5 i stupce 7 i 2.

• A(:,1:3:8)
Podmatrica koja sadrži sve retke i stupce 1, 4 i 7.
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Aritmetički operatori

• A+B, A‐B, A*B – zbrajanje/oduzimanje/množenje matrica
ispravnih dimenzija; oprez: ponašanje je drugačije ako je jedan od
operanada skalar!

• A.*B – množenje element po element, A(r,s)*B(r,s), matrice A
i B su istih dimenzija

• A' – kompleksno konjugirana i transponirana matrica
• A.' – transponirana matrica (bez konjugiranja)

• A^p – matrično potenciranje
• A.^p – potenciranje element po element, A(r,s)^p, p ∈ R

• A.^B – potenciranje element po element, A(r,s)^B(r,s),
matrice A i B su istih dimenzija
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Aritmetički operatori

• A\b – matrično lijevo dijeljenje.
▶ A regularna i kvadratna
⇝ x=A\b je rješenje sustava Ax = b.

▶ A nije regularna ili pravokutna
⇝ x=A\b je rješenje problema najmanjih kvadrata minx ∥Ax− b∥.

Ovo radi i za matrice: A\B računa A−1B.

• A.\B – lijevo dijeljenje po elementima: B(i,j)/A(i,j)
• A/B – matrično desno dijeljenje, isto kao (B'\A')'; računa AB−1

• A./B – desno dijeljenje po elementima: A(i,j)/B(i,j)

Dakle:
• X=A\B⇝ X = A−1B, odnosno AX = B
• X=A/B⇝ X = AB−1, odnosno XB = A
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Logički i relacijski operatori, funkcije

Svi logički i relacijski operatori i navedene funkcije se izvrednjavaju po
elementima.

• ~A (logičko NE), A&B (logički I), A|B (logički ILI)
• A<B, A<=B, A>B, A>=B, A==B, A~=B
• sin, cos, asin, acos, sinh, cosh, asinh, acosh, exp, log, log10,
sqrt, abs, round

Na skalarnim (1× 1) podacima postoje i bitovni operatori &&, || koji
imaju lijeno izvrednjavanje; korisno kod if-ova .
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Specijalne matrične funkcije

Neka je

1 A = [1 2 3 4; 5 6 7 8; 9 10 11 12; ...
2 13 14 15 16; 17 18 19 20]

A =
1 2 3 4
5 6 7 8
9 10 11 12
13 14 15 16
17 18 19 20

Na sljedećim stranicama ispisujemo što razne funkcije vraćaju za ovu
matricu.
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Specijalne matrične funkcije

size( A ) – vektor-redak sa dimenzijama matrice
5 4

length( A ) – najveća od dimenzija matrice (korisno za vektore)
5

min( A ) – najmanji elementi u svakom stupcu. Ako je A
vektor-redak, onda vraća najmanji element. Može vratiti i index.
1 2 3 4

max( A ) – najveći elementi u svakom stupcu. Ako je A vektor-redak,
onda vraća najveći element. Može vratiti i index.
17 18 19 20
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Specijalne matrične funkcije

diag( A ) – vektor-stupac s dijagonalom matrice
1
6
11
16

diag(diag(A)) – ako je input za diag vektor, vraća dijagonalnu
matricu
1 0 0 0
0 6 0 0
0 0 11 0
0 0 0 16

sort([7 3 8 11]) – Sortira uzlazno vektor-redak. Sortira uzlazno
svaki stupac matrice. Može vratiti i permutaciju.
3 7 8 11
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Specijalne matrične funkcije

triu( A ) – gornje-trokutasti dio od A
1 2 3 4
0 6 7 8
0 0 11 12
0 0 0 16
0 0 0 0

tril( A ) – donje-trokutasti dio od A
1 0 0 0
5 6 0 0
9 10 11 0

13 14 15 16
17 18 19 20
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Funkcije numeričke linearne algebre

• norm( A, 1 ), norm( A ), norm( A, inf ), norm( A, 'fro' )
– 1 / 2 /∞ / Frobeniusova-norma matrice A

• [L, U, P] = lu( A ) – LU-faktorizacija matrice A s parcijalnim
pivotiranjem: P*A=L*U

• R = chol( A ) – Cholesky faktorizacija matrice A = R'*R

• [Q, R] = qr( A ) – QR-faktorizacija matrice A
• [Q, R] = qr( A, 0 ) – kompaktna QR-faktorizacija

• eig( A ) – svojstvene vrijednosti (i vektori) matrice A
• svd( A ) – singularne vrijednosti (i vektori) matrice A
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STRINGOVI, STRUKTURE I CELL-ARRAY



Stringovi, strukture i cell-array

String je vektor-redak varijabli tipa char:

1 s1 = 'pero'; s2 = 'mirko';
2 s1( 2:4 )
3 [s1 s2] % konkatenacija ‐‐ kao kod vektora!
4 length( s2 )
5 size( s1 )

ero
peromirko
5
1 4

Postoje i specijalizirane funkcije poput strcmp – vidi Help.
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Stringovi, strukture i cell-array

Strukture mogu sadržavati elemente raznih tipova:

1 s.ime = 'Mirko';
2 s.ocjena = 5;
3 s.matrica = [1 2 3; 4 5 6];
4 s

ime: 'Mirko'
ocjena: 5
matrica: [2x3 double]

Moguće je doznati je li nešto element strukture:

1 isfield( s, 'ime' )
2 isfield( s, 'prezime' )

1
0
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Stringovi, strukture i cell-array

Cell-array jematrično organizirana struktura – elementi mogu biti
raznih tipova, ali nemaju imena već su posloženi u matricu.

1 c{1,2} = 'Pero';
2 c{3,1} = [1 2; 3 4];
3 c{2,2}.ime = 'Mirko';
4 c

[] 'Pero'
[] [1x1 struct]
[2x2 double] []

Za cell-array su dostupne neke matrične funkcije poput size.
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VIZUALIZACIJA REZULTATA



Crtanje grafova

U Matblabu su dostupne brojni alati za crtanje 2D i 3D grafova
funkcija, kontura i slično. Ovdje ćemo kroz nekoliko primjera vidjeti
samo osnovnu upotrebu funkcije plot za crtanje 2D grafova, te
semilogy.

Grafove je moguće dodatno uređivati pomoću editora koji se otvori
prilikom prikaza grafa.
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plot

1 y = [5 7 2 3 8 9];
2 plot( y );

1 2 3 4 5 6
2

3

4

5

6

7

8

9

Na x-osi: 1 2 3 4 5 6. Točke spojene linijom.
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plot

1 x = ‐pi:0.05:pi; y = sin( x );
2 plot( x, y );

-4 -3 -2 -1 0 1 2 3 4
-1

-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

1

Točke spojene linijom.
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plot

1 x = ‐pi:0.2:pi; y = sin( x );
2 plot( x, y, 'ro' );

-4 -3 -2 -1 0 1 2 3 4
-1

-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

1

'ro' = crveni kružići; 'gx' = zeleni x; 'y*' = žute *; 'b+‐' = plavi +
spojeni linijom; 'k.:' = crne točkice spojene isprekidanom linijom
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semilogy

1 x = ‐3:0.1:3; y = exp( x );
2 semilogy( x, y );

-3 -2 -1 0 1 2 3

10-1

100

101

Na y-osi je logaritamska skala. Slično, semilogx, loglog.
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Više grafova na jednoj slici + legenda

1 x = ‐pi:0.05:pi; y = sin( x ); z = cos( x );
2 plot( x, y, 'r‐' ); hold on;
3 plot( x, z, 'b:' ); hold off;
4 legend( 'sinus', 'y=cos(x)' );

-4 -3 -2 -1 0 1 2 3 4
-1

-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

1

sinus
y=cos(x)

hold on – svi naredni grafovi idu na trenutnu sliku.
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image

1 a = 64 * rand( 50 );
2 image( a ); colorbar;

10 20 30 40 50

5

10

15

20

25

30

35

40

45

50

50

100

150

200

250

Kvadratić (i, j) obojan je bojom a(i, j) ∈ {1, . . . , 64}. Za druge palete
boja vidi doc colormap.
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text

1 text( 0.5, 0.5, 'ABC' ); text( ‐2, 1, 'DEF' );
2 set( gca, 'XLim', [‐3, 3], 'YLim', [‐1, 2] );

-3 -2 -1 0 1 2 3
-1

-0.5

0

0.5

1

1.5

2

ABC

DEF
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SKRIPTE I FUNKCIJE



Skripte

Niz naredbi kojeg želimo kasnije ponovno pozvati možemo napisati u
bilo kojem editoru teksta (npr. VS Code) i spremiti u .m-datoteku.

Matlab također ima svoj editor:Window->Editor.

Ako niz naredbi spremimo u datoteku skripta.m, onda ih možemo
redom sve izvršiti tako da u interaktivnoj konzoli napišemo naredbu
skripta.

Važno je da datoteka skripta.m bude

• ili u trenutnom direktoriju (Current Folder)
• ili u putanji (path). Bilo koji direktorij u putanju možemo dodati
preko File->Set Path...
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Skripte

Unutar skripti dostupne su nam standardne naredbe za grananje, te
petlje:

1 if uvjet_1
2 naredba_1;
3 naredba_2;
4 elseif uvjet_2
5 naredba_3;
6 else
7 naredba_4;
8 end

Primjer:

1 if abs( x ‐ y ) < 1e‐8
2 'Brojevi x i y su preblizu'
3 else
4 z = 1 / ( x ‐ y );
5 end
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Skripte

Petlje:

1 for brojač = vektor‐redak
2 naredba_1;
3 naredba_2;
4 end
5

6 while uvjet
7 naredba_1;
8 naredba_2;
9 end

Primjer:

1 for i = 3:2:10
2 suma = suma + i;
3 end

Dostupne su i standardne naredbe break i continue.
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Funkcije

Funkcije također možemo spremiti u .m-datoteku.
Unutar jedne m-datoteke može biti više funkcija, ali samo prvu (koja
mora imati ime kao i datoteka) će biti moguće pozvati izvana. Ostale
funkcije unutar m-datoteke su pomoćne.
Unutar skripte nije moguće definirati funkcije.

Definicija funkcije s 2 parametra i 3 povratne vrijednosti:

1 function [x_1, x_2, x_3] = ime_fje( p_1, p_2 )
2 % kod funkcije...
3 % treba nešto spremiti u varijable x_1, x_2 i x_3.
4 end

Funkciju treba spremiti u datoteku ime_fje.m.

Funkcija se iz konzole poziva sa:

1 [var_1, var_2, var_3] = ime_fje( arg_1, arg_2 );
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Primjer funkcije

U editoru napišemo i spremimo pod imenom suma_kvadrata.m:

1 function s = suma_kvadrata( v )
2 % Funkcija računa sumu kvadrata svih elemenata
3 % vektora‐retka v
4 if( size( v, 1 ) ~= 1 )
5 error( 'Funkciji nije poslan vektor‐redak!' );
6 end
7

8 s = 0;
9 for i = 1 : length( v )

10 s = s + kvadrat( v( i ) );
11 end
12 end
13

14 function k = kvadrat( x )
15 k = x .^ 2;
16 end
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Primjer funkcije

U konzoli pokrenemo:

1 v = [2 5 1];
2 x = suma_kvadrata( v );
3 x

30

Funkcija kvadrat nije dostupna iz konzole!

Matlab prosljeđuje parametre po vrijednosti – dakle, funkcija ne može
promijeniti varijablu koja joj je poslana (stvara se lokalna kopija
unutar funkcije).
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Zadatak 1: QR faktorizacija

1 Napišite funkciju [Q, R]=cgs(A) koja izračunava
QR-faktorizaciju matrice A koristeći klasični Gram-Schmidtov
algoritam:

q̃k = ak −
k−1∑
j=1

(qTj ak)︸ ︷︷ ︸
R(j,k)

qj

2 Napišite funkciju [Q, R]=mgs(A) koja izračunava
QR-faktorizaciju matrice A koristeći modificirani
Gram-Schmidtov algoritam: u gornjoj sumi (petlji) treba
zamijeniti ak sa q̃k.

3 Usporedite “ortogonalnost” faktora Q dobivenog pomoću funkcija
cgs i mgs, te Matlabove funkcije qr.
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